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Easy CD Creator 4
Introduction
Use Easy CD Creator, the award winning CD recording software, to 
make your own CDs. In just a couple of mouse clicks, you can create 
Audio CDs that can be played on your home or car stereo CD player, 
or create Data CDs to store data such as the files and folders on your 
hard disk.

This Quick Reference Guide provides instructions on performing 
the most common tasks with Easy CD Creator. To get a more com-
prehensive set of instructions, refer to Easy CD Creator’s Online 
Help.
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Deluxe Edition Features
To expand your CD recording capabilities, upgrade to Easy CD 
Creator 4 Deluxe. With Easy CD Creator 4 Deluxe, you get these 
additional features:

Ordering the Deluxe Edition
If you are using the Easy CD Creator Standard Edition and would 
like to upgrade to the Deluxe Edition, you can:

■ Contact your nearest software retailer

■ Or call Adaptec to order now:

– US 408-957-7274

– UK 0800 96 65 26

– Rest of Europe +32 11 300 379

– Outside Europe and US +408-957-7274

Features Uses

CD Spin Doctor™ Make Audio CDs from traditional music sources including 
LPs and cassette tapes, and clean up the sound quality 
before recording songs to CD

Session Selector View any previous session of a multisession CD, not just the 
last session

Sound Editor Make changes to sound files on your hard disk before 
recording them to CD

Video CD Creator Make CDs containing videos or still images

PhotoRelay™ Create slide shows, web albums, and video postcards

Take Two™ Back up the entire contents of your hard disk to a single CD 
or multiple CDs

MGI® PhotoSuite® II SE Easily retouch and transform photos, remove red eye, and 
add special effects

MGI® VideoWave® II SE Edit video clips, add titles, transitions, audio, and special 
effects

Track Transition Effects Add fade in, fade out, and cross fade effects between songs
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Installing Easy CD Creator
To install Easy CD Creator:

1 Insert the Adaptec Easy CD Creator CD into your CD-Recorder 
or CD-ROM drive. 

Note: In this guide, the term CD-Recorder refers to both 
CD-Recordable and CD-ReWritable drive.

If Autorun is enabled on your system, the Adaptec Installation 
window appears automatically and you can skip steps 2 and 3.

2 From the Start menu, select Run.

3 Type d:\setup (substitute the appropriate letter of your 
CD-Recorder or CD-ROM drive for d).

4 From the Adaptec Installation window, select Adaptec Easy 
CD Creator.

Note: Internet Explorer 4.01 or higher must be 
installed on your system before you can install Easy 
CD Creator. If Internet Explorer is not found on your 
system, you are prompted to install Internet Explorer 5 
before continuing with Easy CD Creator installation.

5 Follow the installation instructions that appear on the screen.

6 When the installation is complete, click Finish. The Adaptec 
Installation window appears again.

7 Click Exit to exit the Adaptec Installation window.

8 Restart your computer when prompted for the changes to take 
effect.
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Starting Easy CD Creator
There are two ways to start Easy CD Creator so you can begin creat-
ing your own CDs; from the Start menu or by using the Create CD 
menu. See Using the Create CD Menu below.

To start Easy CD Creator from the Start menu:

■ On the Windows taskbar, click the Start button, point to 
Programs, point to Adaptec Easy CD Creator 4, point to 
Features, and select Easy CD Creator.

Using the Create CD Menu
The Create CD menu appears when you first restart your computer 
after installing Easy CD Creator, or whenever you insert a blank CD 
into your CD-Recorder. You can also open the Create CD menu from 
the Start menu.

To open the Create CD menu from the Start menu:

■ On the Windows taskbar, click Start button, point to Programs, 
point to Adaptec Easy CD Creator 4, and select Create CD.

Using the CD Guide
The CD Guide is the animated character that helps you through the 
steps of creating Audio CDs, Data CDs, and designing custom jewel 
case inserts and CD labels.

To show or hide CD Guide:

■ Click the  CD Guide button on the toolbar.

Creating an Audio CD
Use Easy CD Creator to create an Audio CD (also known as a music 
CD) that can be played on your home or car stereo CD player, and 
every computer that has a CD-Recorder or CD-ROM drive. Unlike a 
Data CD, an Audio CD is used for playing back music and not for 
data storage.

To create an Audio CD:

1 Open Easy CD Creator from the Start menu. Click Start, point 
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2 Open an Audio CD Layout. Click the small arrow next to the 
New button on the toolbar and select Audio CD from the 
drop-down list. An Audio CD Layout appears.

3 Insert a blank CD into your CD-Recorder (the destination 
drive).

4 If you are recording tracks from an existing music CD, insert the 
music CD into your CD-ROM drive (the source drive). If you 
are recording WAV or MP3 files, continue with the next step.

Note: You can record any combination of tracks, WAV, 
or MP3 files to an Audio CD.

5 In the left pane of the Explorer section, select the CD-ROM 
drive containing the music CD; a list of the tracks on the CD 
appear to the right. If you are recording WAV or MP3 files, 
select the folder where your files are located.

Note: If information about the music CD is found 
locally on your hard disk, the CD title, artist name, and 
the name of each track are displayed. If this informa-
tion does not appear, and you have access to the Inter-
net, click the CDDB Internet button on the toolbar to 
download the information from the online CDDB™ 
Disc Recognition Service. (AOL users must have an 
active Internet connection prior to clicking the button.)

6 Select the audio track, WAV, or MP3 file you want to record in 
the right pane of the Explorer section, and then click Add. 
Repeat until the Audio CD Layout contains all of the tracks 
and files that you want to record.
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Note: If you have tracks on other music CDs that you 
want to record, repeat steps 4-6 for each music CD 
from which you want to record. During the actual 
recording process, Easy CD Creator prompts you to 
reinsert the appropriate music CD for the track being 
recorded.

7 Click Create CD. The CD Creation Setup box appears.

8 Click OK to start recording.

Creating a Data CD
With Easy CD Creator, you can create a Data CD to store computer 
data such as the files and folders on your hard disk. This is especially 
useful for backing up your important files, or sharing them with your 
colleagues. Unlike an Audio CD, a Data CD is used for data storage 
only and cannot be played on your home or car stereo CD player.

To create a Data CD:

1 Open Easy CD Creator from the Start menu. Click Start, point 
to Programs, point to Adaptec Easy CD Creator 4, point to 
Features, and then select Easy CD Creator.

2 Open a Data CD Layout. Click the small arrow next to the New 
button on the toolbar and select Data CD from the drop-down 
list. A Data CD Layout appears.

3 Insert a blank CD into your CD-Recorder (the destination 
drive).

4 In the Explorer section, select the data file or folder you want 
to record, and then click Add. Repeat until the Data CD Layout 
contains all of the files and folders that you want to record.

5 Click Create CD. The CD Creation Setup box appears.

6 Click OK to start recording.
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Duplicating a CD
The most common use for making a copy of a CD is to create a 
working copy of a CD and archive the original in a safe place. Use 
CD Copier to duplicate a CD.

Note: Easy CD Creator is designed to assist you in reproduc-
ing material in which you own the copyright or have obtained 
permission to copy from the copyright owner. Unless you 
own the copyright or have permission to copy from the copy-
right owner, you may be violating copyright law and be sub-
ject to payment of damages and other remedies. If you are 
uncertain about your rights, contact your legal advisor.

Also, check the end-user license on any commercial CDs to 
determine whether the license permits you to make copies. 
For example, some game disc licenses specifically exclude any 
kind of copying; it is therefore illegal to copy them for 
personal use.

Starting CD Copier
To start CD Copier:

■ On the Windows taskbar, click the Start button, point to 
Programs, point to Adaptec Easy CD Creator 4, point to 
Features, and select CD Copier.

Duplicating a CD
To duplicate a CD:

1 Insert the original CD from which you want to make copies 
into your CD-Recorder or CD-ROM drive.

2 On the Source and Destination tab, select the drive containing 
the original CD in the Copy from drop-down list box.

3 Select the destination drive that contains the blank CD in the 
Record to drop-down list box. This is your CD-Recorder.

4 Click Copy to begin recording a copy of your CD.
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Using Jewel Case Creator
Use Jewel Case Creator to make custom jewel case inserts and CD 
labels to indicate the title and contents of your CD.

Jewel Case Creator comes with a variety of themes which include 
different graphics and text layouts for Audio and Data CDs. You can 
also add your own graphics, change backgrounds, and change the 
layout and style of the text to give your insert and label a custom 
look. 

The following sections describe the most common tasks you can 
perform with Jewel Case Creator. For additional instructions, refer 
to Jewel Case Creator ’s Online Help.

Starting Jewel Case Creator
To start Jewel Case Creator:

■ On the Windows taskbar, click the Start button, point to 
Programs, point to Adaptec Easy CD Creator 4, point to 
Features, and select Jewel Case Creator.

Adding Contents of an Existing CD
The Add CD Contents feature is the easiest way to fill in the CD title, 
artist, and a list of tracks for jewel case covers and inserts.

To get the contents of an existing CD:

1 Insert the existing CD into your CD-Recorder or CD-ROM  
drive. If you have more than one drive containing a CD, Jewel 
Case Creator prompts you to select the drive containing the 
CD you want to use.

2 From the Add menu, select CD Contents.

Jewel Case Creator adds the information from the CD into the 
appropriate text boxes (such as Title, Artist, and Tracks). For 
audio CDs, if the information can not be found locally, Jewel 
Case Creator uses the Internet to download the information 
from the CDDB™ Disc Recognition Service.
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Selecting Themes
Jewel Case Creator allows you to select from a variety of themes that 
come with the application. Themes contain both backgrounds, such 
as graphics, and text layouts designed for either audio or data CDs.

To select a theme:

1 From the Format menu, select Change Themes. The Change 
Theme dialog box appears.

2 Select a theme you want to use from the Available Themes list. 
When you select a theme, a preview of the theme appears on 
the right side of the dialog box.

Note: When you change a theme, the contents of your 
insert or label are not affected; however, you can not  
undo any changes you made prior to changing the 
theme.

3 Click OK.

Printing Covers and CD Labels
The following sections describe selecting paper types, and printing 
covers and labels.

Selecting the Paper Type
Jewel Case Creator includes a list of paper types in which the posi-
tioning of the cover and label pages has already been determined for 
the selected cover and label stock paper types.

Note: You must select a paper type the first time you print a 
cover or label. 

You can also change previously selected paper types by following 
these steps:

1 From the File menu, select Page Setup.

2 Click the cover or CD label you want to print: Front/Inside 
9
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3 From the Current paper type drop-down list box, select the 
paper you want to print to. Jewel Case Creator lists the cur-
rently supported cover and label stocks. If the third-party 
cover or label stock you want to use is not listed, select Generic 
(plain paper).

4 Continue selecting the paper types for each cover and/or label 
you want to print.

5 Click OK. 

Printing the Covers and Labels
To print a cover or CD label:

1 From the File menu, select Print. The Print dialog box appears.

2 The first time you print a cover or label, you must select a 
paper type. See Selecting the Paper Type on page 1-9.

3 Under Paper, select the cover and label pages you want to 
print. You can select more than one cover and label to print at a 
time if you have selected a corresponding paper type.

4 For some paper types, such as some of the CD label stock, 
select which label or cover object on the paper you want to 
print. Jewel Case Creator prints the object that is highlighted.

5 Click OK.

Getting Help
For set-up and connection problems with your CD-Recorder, refer to 
the manufacturer ’s Installation Guide.

For problems with the Adaptec software, explanations of error mes-
sages, and more, refer to the software’s Online Help.

❒
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